[bookmark: _Toc409015076][bookmark: _Toc444603416]Practical 4 
[bookmark: _Toc409015077][bookmark: _Toc444603417]Comparing actual progress with planned progress
· One of the reasons for developing your project schedule is to allow you to compare actual progress with planned progress. You can accomplish this by saving a baseline as a snapshot of your original schedule before your project gets rolling and then recording actual progress as the project progresses. 
· [bookmark: _GoBack]This practical is to demonstrate some of the Microsoft Project features to help you to compare actual progress with planned progress. To demonstrate the Microsoft Project features we will probably have to set imaginary data about the status of tasks for a time in the future (unless you are very behind in your practicals).  This is not something you would do in reality.
· Open practical3.mpp file (if it is not already open) and save to a file called practical4.mpp. You now have a copy of your work to use in practica4.mpp. You will use practical4.mpp as the starting point for this week’s practical. Close practical3.mpp
· If it is not already open, open practical4.mpp by double clicking on the file.
[bookmark: _Toc409015078][bookmark: _Toc444603418]Saving the baseline 
Now that we have identified tasks, predecessor relationships, added durations, assigned resources and resolved the resource issues, we are ready to save our plan as a baseline plan. This will allow us to compare actual progress with planned progress when the project is underway.
· To save the baseline plan, return to the Gantt chart view then click on the Project tab and select “set baseline” from the “Set Baseline” drop-down list in the Schedule group. 
· Select “set baseline”. As this is the original baseline it should just be called baseline. 
· Click the “for the entire project” option followed by OK to complete saving the baseline.


	[image: SetBaseline]
[image: ]

[bookmark: _Toc444603419]Viewing the Tracking Gantt Chart
If you now view the tracking Gantt chart it will display both the current schedule (bars on top) with the baseline tasks bars below them.  
To view the Tracking Gantt chart select the Tracking Gantt option from the drop down list you see when you click on “Gantt Chart” in the top left hand corner when you are viewing the task ribbon. (You may need select “entire project” from the zoom section of the View ribbon to see the whole chart clearly.)
[image: ]

Your Tracking Gantt chart should appear similar to the following extract:
[image: ]
[bookmark: _Toc409015079][bookmark: _Toc444603420]Inserting a status report date
· Now suppose that you are in the executing stage of the project. In that case you will want to update the schedule to accurately record the actual status of your project on a regular basis. You can do this in Microsoft Project and you can use various features to help you to analyse the status of your project. 
· To begin, you need to collect progress data from your team up to the particular status date. You will be given some status information to experiment with shortly. In this practical exercise we are demonstrating some of the Microsoft Project features. However, we are not actually in the executing stage of the project so we are going to artificially select a status date. This could be in the future or past depending on how quickly you are progressing through the practicals. Ignore this anomaly for the purposes of this exercise. 
· For this practical, you are to select the project status date to be the Friday of the 4th week into your project. (This assumes that you correctly started your project on a Monday as requested in practical 1. If that is not the case make the appropriate adjustments.)
· To set the status date select “Project Information” from the Project properties group on the Project ribbon. Enter the status date and click OK.  (The screen shot below does not have the actual date that you need to select for your status date. The date will depend on when you started these practical exercises.)

[image: ]
· Record your progress status date here. 			
· It can also be helpful to view the status data as a “gridline” on the Gantt Chart (and Tracking Gantt Chart). To achieve this, click on the drop down arrow below the “Gridlines” icon in the “Format” area of the Format ribbon. 
· Select gridlines from the options displayed. 
· In the pop up window that appears, scroll down the “Line to change” list and click “Status Date”. Make selections for the type and colour that will stand out clearly on your Gantt Chart. (For example, a solid line coloured purple.)
[image: ]

You should now see a line showing the status date on your Gantt Chart.
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[bookmark: _Toc444603421]Setting Options Before Updating Task Status
· There are several settings/options related to updating tasks. Mostly the defaults are what we would want in most cases. However, there are some settings in the advanced category that need to be modified before we enter some status data for the project. 
· To change the settings, go to File->Options and select “advanced” as shown below. 
[image: ]
· Scroll down through the advanced options and modify the “calculation options for this project” as shown in the screenshot below:
[image: ]
The following information explains what we have modified.
“Move end of completed parts after the status date back to the status date” – this means any completed work will be moved moved back to before the status date i.e. the work is now recorded as having been completed in the past.
“And move start of remaining parts back to status date” – means any incomplete parts will start at the status date, i.e. if they were scheduled further in the future they can now start back at the status date.
“Move start of remaing parts before the status date forward to the status date” – meaning that as they have not been completed before the status date, they are now scheduled to be completed in the “future” (from the status date).
“And move end of completed parts forward to status date” – means that the completed and incompleted portions of the task are joined at the status date.

[bookmark: _Toc409015080][bookmark: _Toc444603422]Information about actual progress

· Click on the View tab and select the “Tracking” table from the drop-down list of tables in the Data group.

[image: TrackingTable]
· You will now have a view of the table in which you can view the actual start date, actual finish date, % complete etc. You can read more about the meaning of each of the different headings by placing the mouse over the heading. You can also Microsoft Help to find more detailed information. 
· As you can see there are a number of fields available for recording status information. To update  status information you need to enter the following information about tasks that have started(or completed):
1. Actual start date – record in the Act. Start column
2. What has been completed – you can record either the actual duration (Act. Dur. Column), actual work (Act. Work) or percentage completed (see note below regarding PMI’s recommendation regarding % complete).
3. What still needs to be completed – you can record either the estimated remaining duration (Rem. Dur.) or the estimated remaining work (an additional column that can be added).
· For the purpose of this exercise, we will assume that we have the actual start dates, actual durations and estimates of the remaining duration (or finish dates if the task has completed) for tasks that have started before the status date we select. Requesting this information can often be the quickest way to get accurate status data from team members
Notes: 
1. Microsoft Project will calculate the values for any of the status fields that you don’t update directly. For example, if you entered the actual start date, the actual duration and remaining duration, it will calculate the following:
· Duration = actual duration + remaining duration
· % Complete = (actual Duration /Duration) * 100
2. Given that that it can be difficult to accurately estimate the % complete of a task that has started, but is not yet 100% complete, the PMI’s Body of knowledge has two recommendations for “complete” when carrying out earned value analysis:
1) All or nothing. A task is either complete (100%) or incomplete. If incomplete it is not included in any earned value calculations. 
2) Unstarted, started or complete. Unstarted should be set to 0% complete, started should be set to 50% complete and complete tasks should be set to 100% complete.
A third alternative when performing earned value calculations is to specify what is believed to be the “actual % complete” and use this value in the calculations. 
As stated earlier, we will assume that we have the actual start dates, actual durations and estimates of the remaining duration (or finish dates if the task has completed) for tasks that have started before the status date. 

[bookmark: _Toc444603423]Entering Some actual Status Information
· Remember that we have entered the status date as the Friday 4 weeks into your project. We will now enter some status data for tasks that were scheduled to start before this date. 
· In the exercise you will see how to update tasks that are running on schedule, update completed tasks that didn’t run on schedule and update tasks that are in progress. 
· When entering status data, it can be quite helpful to filter out the tasks that you expect to need to be updated because they are scheduled to have started before the status date. To view those tasks, go to the View ribbon and select “More filters” from the filter drop down list. 
[image: ]
· If you the select the “Should start by” option and click on the “apply” button, you will be asked to enter the “should start by date”. Enter your status report date and click OK. 
Updating Tasks Running On Schedule
· This step is to demonstrate how easy it is to update tasks that are running on schedule. We will “undo” this update in the next section so that we can explore how to enter information about tasks that are not running on schedule. 
· Select the “Information Gathering” and “Define Requirements” tasks.
· Select the “Mark on track” option from the drop down list of “Mark on Track” found in the schedule area of the Task ribbon. 
· The status for the two tasks should be updated and your Tracking Gantt Chart should be similar to the following:


[image: ]
Updating Completed Tasks that did not Run on Schedule
· In this situation it is best to enter the actual start and finish dates for the task. 
· Before we start entering the status data, undo the previous status updates simply by clicking the undo arrow at the top of Microsoft Project.
[image: ]
· The Tracking Gantt Chart should now be similar to the following (i.e. no status data has been entered yet).

[image: ]

· Let us assume that the “information gathering” task has been completed, but that it finished in 2 weeks rather than the estimated 3 weeks in the original schedule. To enter this information, select the “information gathering” task, then click the down arrow on the right of the “Mark on Track” button and select “update tasks”.
· You should now see a pop up window that will allow you to enter the Actual start and finish dates.
· Enter the actual start date (assume that the task started on time).
· Work out the date when your “information gathering” task should be completed if it only took 2 weeks and enter that data in the “Actual Finish” date. (Note that there is a drop down calendar that you can use to help you with this.)
· Click the OK button.
· Your “tracking Gantt Chart” should be similar to the following:
[image: ]
· You can see that now the “define requirements” task can start 1 week earlier than originally scheduled. Assume that this task started as soon as the information gathering task was completed and that it was completed in 1 week and not the originally estimated time of 3 weeks. Update the status for this task.
· Your tracking Gantt Chart should now be similar to the following:

[image: ]
· Given that the previous tasks were completed early, there could be other tasks that are now able to have been started before the status date. Apply the filter again to identify those tasks.
Updating Tasks that are in Progress (but not necessarily progressing according to schedule)
· In this situation it is best to enter the actual start, the actual duration (so far) and the estimated remaining duration. 
· Based on the data we have entered so far, you should now see that “disk storage” purchase could have been completed and that the “design programs” and “design (advertising brochure) could have been started. However, the two design tasks would not be expected to have been completed by the status date. 
· Let us assume that “design programs” started as soon as its predecessor finished (meaning that one week of work should have been completed up to the status date). Assume that this task is also going well and the designers expect to complete the design work in another week.
· Select the “design programs” task and again click on the “update tasks” option from the “Mark on Track” list. 
· Enter the start date (the new start date given that the predecessor has finished early), an actual duration of 1 week and a remaining duration of 1 week.
· Finish updating the status of your project by completing the status information for “disk storage purchase” and “advertising brochure design”. Assume that they both started as soon as their predecessors were finished and that you expect them to take the originally estimated duration.
· Remove the filter so that you can view the whole Tracking Gantt Chart.
· If you are not already viewing the tracking Gantt chart, select that view.  
· Return to the entry table (accessed through tables in the View ribbon) to answer the following questions:
1. What is the new duration for the project based on the current data?    
__________________
2. What is the new finish date for the project based on the current data? 
__________________  
3. Have these changed and if so, what is the change? 
__________________________________                           
[bookmark: _Toc409015082][bookmark: _Toc444603424]Viewing earned value
· Select “Table” in the View ribbon followed by “more tables”. Double click on “earned value” in the list of available tables and click the “Apply” button. 

[image: ]
· You will now be able to view a table with the headings - Planned Value (BCWS), Earned Value (BCWP),  AC (ACWP), SV ,CV, EAC, BAC and VAC. Note that Microsoft Project still has the old acronyms in the headings as well as the names and acronyms that you should be familiar with from this course. 
Simple definitions:
PV – the planned value – planned budget based on the original estimates up to the status date you have set. 
EV – the “earned value” of the work completed so far (i.e. based on the % complete  - calculates that % of the value of the original estimate to complete the whole task.)
AC – the actual cost to date (e.g. the actual cost for the number of hours worked on the task).
EAC – also known as the forecasted cost at completion. It is calculated in Microsoft using the following formula:
EAC = AC (so far) + (baseline cost – EV (so far))/CPI
BAC – total planned cost for the task.
VAC – Variance at completion (= BAC – EAC)
There is also a help link available if you hover above any of the headings in Microsoft Project.
· From the table you should be able to complete the following information for your project. (Note: You are to fill in the blanks and select the appropriate option where you are given a choice in brackets. Choices are in italics. )
The planned budget for this project to spend by the status date you have selected is                           . (From the PV (BCWS) column in row 1 for the whole project) 
So far the project has earned 			  in terms of the work completed (from the Earned Value column in row 1)
At the same time, it has actually spent   		 (from the AC column in row 1)

According to the table, there is			  (SV) (worth of work that was supposed to have been completed that hasn’t been done yet/additional worth of work that has been completed that was not scheduled to be completed yet)  and of the existing work that has been carried out so far, the project is 		 (CV) (over/under) budget. 
You can also look at the variance at completion (VAC).  This takes into account the CPI we have generated so far – if this continues over the rest of the life of the project we can expect to be 			 (VAC) (over/under) budget. 
VAC is calculated by subtracting the EAC  (forecasted cost at completion) from the BAC (planned cost). EAC is calculated using the CPI. If you hover over the heading for this column (or any of the others) you can see formula used for the calculation in Microsoft Project. It was also given in the definitions above.
Note that if you were actually monitoring the project, you would also check that the variations have not re-introduced any resource allocations issues. If that was the case, it would be necessary to resolve the problems. We will not investigate this aspect of the project in the lab exercises.
· As you probably noticed, the schedule variance is measured in terms of dollars. If it is negative it indicates that we are “behind schedule” in the sense that there is work that should have been carried out that has not been done. Similarly, if it is positive, it is an indication that we are “ahead of schedule” in the sense that there is additional work that has been completed that was not scheduled to have been completed by this stage in the original plan. Note however that a negative schedule variance does not necessarily mean the project will not finish on time. 
1. Why not? When do you think a project might have a negative schedule variance, but still be able to finish on time (or even ahead of time)?  	
								_____________
										
									______	
										
										
The SV is useful to identify whether or not there is work that should have been carried out that has not been completed yet. However, SV does not give us information about when the project is expected to finish (or when tasks within the project are expected to start and finish once the project is underway). By viewing the variance table you can also see what is happening in terms of the actual finish dates for activities in the project and the overall project.
Similarly, although a positive SV is a good sign, it does not guarantee that the project will finish early. Again you should check the Tracking Gantt chart and view the variance tables to check your schedule status.  
[bookmark: _Toc409015083][bookmark: _Toc444603425]Viewing the start and finish variances
· Select “Tables” from the View ribbon and then select “Variance” from the list of tables. This will result in the display of a table with the headings start (actual recorded or predicted start dates), finish (actual recorded or predicted finish dates), baseline start, baseline finish, start variance and finish variance. In the case of those activities that have been completed the start and finish variances are the actual variances, in the case of those activities that have yet to be started or completed, the variances are based on what we know already know and what we expect to happen. 
Answer to the question in the previous section: It is possible to have a negative schedule variance because the project is late on non critical tasks, but it could finish early or on time if the project is running on time or ahead on the activities on the critical path/critical chain.  By viewing the variance table you can see what is happening in terms of the start and finish dates once the project is underway. (Check your answers to the questions in the previous section.)

[bookmark: _Toc444603426]
Viewing the CPI 
· Select Tables from the View ribbon followed by “more tables”. 
· Select “Earned Value Cost Indicators”

[image: ]
· What is the CPI for your project?				   
· What does this mean? 						    
· Is it good or bad? 							 

· Note also that the TCPI tells us how much we would have to earn on the remaining work to achieve the original target. What is the TCPI for this project? 				
· Is that good or bad? 						


[bookmark: _Toc409015084][bookmark: _Toc444603427]Viewing the SPI 
· Select Tables from the View ribbon followed by “more tables”. 
· Select “Earned Value Schedule Indicators” and click the Apply button.
[image: ]
· What is the SPI for your project? 						  
· What does this mean? Is it good or bad? 					 
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